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LENEL MultiMedia Works Version 1.5
Universal Multimedia Application for Windows 

Release Notes:
_____________________________________________________________________________

> The following Windows MCI drivers are included for your use:
- Autodesk FLI/FLC Animation
- Gold Disk AWA/AWI Animation
- Microsoft MMP Animation
- Microsoft Video for Windows
The drivers are located in the OEMDRV subdirectory of your installed
MultiMedia Works.
TO USE these drivers, they must FIRST be installed via the 
Windows Drivers applet in the Windows Control Panel.
 

> We have included sample Macros to access MultiMedia Works from several
Windows application programs, including AmiPro, Word for Windows and 
Excel.  These macros and a README.WRI file detailing their installation and 
use can be found in the MMWMACRO subdirectory.



Introduction

Several Multimedia Functions In One Package

MultiMedia Works offers Windows users several powerful multimedia functions in one easy-to-use
package.  These functions include:

Multimedia Player
to play animation, audio, video, graphic and document data from digital and 
analog sources with the simplicity of  the Windows environment

Multimedia Show Builder
to sequence and synchronize graphics, animation, audio and video into attention-
grabbing presentations

Multimedia-Enabling Server
to embed multimedia into different applications using a variety of Windows 
conventions (e.g., clipboard, OLE, DDE, command-line interface, DLL*)
*DLL is available only with the MultiMedia Works Developer's Toolkit.

Multimedia Mail
to create, send and display multimedia messages
Multimedia Mail is available only if you are using Microsoft Windows for 

Workgroups.

To take advantage of the powerful features of MultiMedia Works, you must first install and 
configure the software for your use.  Read on to find out how.



Installation
If you haven't already installed MultiMedia Works on your computer, follow this procedure to do 
so:

1. Make sure that Microsoft Windows is active and that the Program Manager screen is 
displayed.

2. Insert the MultiMedia Works Installation diskette into the appropriate floppy disk drive of 
your computer.

3. Select the File command in the menu bar.
The Program Manager menu will be displayed.

4. Select the Run command from the drop-down menu.
The Run window will be displayed.

5. Enter A:\INSTALL in the Command Line field of the Run window.
Note: If you are installing MultiMedia Works from a drive other than A:, substitute the 

correct drive letter when typing the command in this step.
6. Select the OK screen button or press <Enter> from your keyboard.

A brief message will be displayed while the installation program copies itself to a 
temporary directory. After the files are copied, the installation program will present you 
with a series of Menu Choices and message windows from which you can select the 
desired installation drive and directory (default is c:\mmworks). Follow the on-screen 
prompts to complete the installation.

When the installation has successfully completed, a window will be displayed when MultiMedia 
Works has been successfully installed. A Program Group will be created containing icons for the 
MultiMedia Works application.

To initiate a MultiMedia Works session, double-click on the MultiMedia Works icon. The 
MultiMedia Works base screen will be displayed.



Setting Up Your MCI Drivers

MultiMedia Works uses Windows Media Control Interface (MCI) drivers to:
-  Play multimedia files including animation, digital video, MIDI and Waveform audio files.
-  Control peripheral devices such as audio and video boards, and CD-ROM players.

To be able to play certain kinds of multimedia data, the appropriate MCI drivers must first be 
correctly configured under Windows. Note that different devices may require special setup or 
operational procedures.

General MCI Driver Installation

To install any of the included drivers, perform the following steps:
1. In order for the LENEL MCI drivers to be properly installed, some boards require that 

vendor provided software be installed prior to installing the LENEL MCI driver.  Please 
consult the section below for board specific installation requirements.

a. From the Windows Control Panel, select the Drivers applet.
b. Select ADD...
c. Select Unlisted or Updated Driver.
d. You will then be asked for the disk with the unlisted, updated or vendor provided 

driver.  Enter the pathname of the location of the drivers (i.e. C:\MMWORKS\
OEMDRV).  (Note: rather than typing the full pathname, the BROWSE option in 
this window can be used for locating the drivers directory.)

e. A list of available drivers will be displayed.  Select and ADD the driver you 
require.

f. Repeat steps b through e for each additional driver you wish to install.

Consult you Windows documentation for detailed instructions regarding adding unlisted 
or updated MCI drivers to you computer. For additional information on a particular 
peripheral device, consult the documentation supplied with the device and/or driver.

Once correctly configured in Windows, the MCI drivers must be defined and activated in 
MultiMedia Works. When you run MultiMedia Works for the first time, the software will search 
your hard disk and attempt to identify available MCI drivers. Even so, you should perform the 
following 3 procedures the first time that you run MultiMedia Works, and whenever you add an 
additional driver as well. This will ensure that MultiMedia Works will be able to use the drivers to 
play associated multimedia data.

If you will be using analog peripheral devices with MultiMedia Works, you will also need to:
-  Install the appropriate MCI drivers for your peripheral devices
-  If applicable, define and activate peripheral device drivers for video decks, laser disc players, 

etc.
-  If applicable, define the devices connected to your video board

Scanning System Devices and Drivers

To scan your hard drive for existing MCI drivers:

1. From the MultiMedia Works base screen, select the System Config... menu option from 
the Options drop-down menu.
The System Configuration window will be displayed. This window includes the following:
-  drivers list area - lists the MCI drivers available for MultiMedia Works. Located in the 

topmost portion of the System Configuration window.
-  Driver Definition area - provides an area to add or change MCI drivers including those 

for peripheral devices connected to your computer, as well as to define the 



communication ports and addresses of these devices (if applicable).

2. From the System Configuration window, click on the SCAN button.

MultiMedia Works will query Windows for installed MCI drivers. After the scan has completed,
recognized drivers for video boards and external devices will be listed as INACTIVE in the 
Available Drivers list.  All other recognized drivers will be listed as "ACTIVE".



Activating MCI Drivers

After MCI drivers are defined, they need to be activated before they can be used in MultiMedia 
Works.

To activate a driver:
1. From the Available Drivers area of the System Configuration window, select the entry for 

the device to be activated.
2. Click on the TOGGLE button. Note that the status changes from "Inactive" to "Active".

If you instead receive an error message, one of the following conditions may exist:
-  The selected device driver is set to a communication port that is already in use (i.e., 

another active device is already connected to the same port)
-  You are trying to activate a video board when another video board is already active
-  An active VISCA device using a shared communi- cations port has the same address 

as the selected driver
3. Activate other drivers in the same manner, or click on the EXIT button to close the 

window.

Configuring Video Board Inputs

After setting up and activating a video board, you must configure the following parameters for 
each input device connected to the board:

-  Input Device Type
-  Signal Type
-  Assigned Audio Input

To configure a video board's inputs:
1. From the System Configuration window, select the desired active video board from the 

list of Available Drivers.
2. Click on the I/O CONNECTIONS button.

A corresponding Video Display Board Connections window will be displayed. Some of the
Video Input areas may not be accessible, depending on the video board selected.

3. Click on the Input Device down-arrow button in the Video Input 1 area.
A list of defined and activated peripheral devices will be displayed.

Note that, if you are using a video board with a manually-controlled device (such as a
VCR), the drop-down list may contain no devices from which to choose. In this 
situation, we suggest that you return to the System Configuration window, select 
"Video Signal" from the Type drop-down list, then ADD it and TOGGLE it to "Active". 
Then click on the I/O Connections button to return to the Video Display Board 
Connections window.You will then find a "Video Signal" entry in the drop-down list of 
Input Devices.

4. Select the appropriate device from the drop-down list.
5. Select the appropriate settings for the Signal Types and Audio Input for Video Input No. 1.

Available settings include:
-  NTSC (U.S.) or PAL (European) signal format
-  S-Video, RGB or Composite signal format
-  1, 2 or 3 for the audio input used with the selected device for Video Input 1.

6. If applicable, repeat Steps 3-5 for other inputs available from the active video board in the
Video Input 2 and 3 areas.

When all the video inputs have been defined:
7. Click on the OK button to save your settings and return to the Systems Configuration 

window.



Multimedia Player

Drag & Drop Object Play: Playing Individual Objects

With the Multimedia Works application software open:
1. a. Initiate Windows File Manager by either:

- selecting Start File Manager from  MultiMedia Works' Control-Menu box
- or selecting the F4 function key ("Start File Manager")

b. Resize the windows so that both the File Manager and MultiMedia Works
windows are visible.

c. Select the desired file in File Manager and drag-and-drop it over the 
MultiMedia Works window.  The object will play automatically in a 
MultiMedia Works display window.

2. As an alternative to using File Manager, you can use MultiMedia Works' Open 
File control (button).  This control will display a Lenel Open File dialog window for
selecting and loading files.  The control can be accessed from any MultiMedia 
Works display window, even if an object is already displayed in the window.

3. After playing the object, select the Exit control in the MultiMedia Works display 
window.

Note: You can also press the Esc(ape) key to close the display window.

Drag & Drop Object Play:  Playing Multiple Objects

You can also select multiple objects from File Manager to play them sequentially.  When multiple 
files are selected, they are played back in MultiMedia Works Show windows.  Show windows are 
similar to object display windows, but contain a different set of controls.  Show window controls 
enable you to move around between objects in a show.

Playing multiple objects using basic show controls is described below.  Creating and playing 
shows is described in the Multimedia Show Builder section of this document.

To play multiple files using drag-and-drop from the MultiMedia Works application base screen:
1. Display File Manager by pressing the F4 key.
2. Reconfigure your screen so that both the File Manager and MultiMedia Works 

windows are visible at the same time.
3. In File Manager, use a standard Windows file selection technique (employing the 

<Ctrl> or <Shift> key) to select those files that you wish to play.
4. Drag the files over the MultiMedia Works window and release the mouse button.  

Each object will play, then advance to the next object automatically.

If you wish to manually advance the show objects:
5. Select the Advance control in the show window to advance to the next object.  

Repeat this step until you have viewed all desired objects.

After displaying the last object, the show will automatically terminate and you will be returned to 
the base screen.

Note: You can abort the show at any time by pressing the End key or by 
selecting the Stop control in the show window to return to the MultiMedia 
Works base screen.



Double-Click Object Play

By Registering File Extensions, you can double-click on a file in File Manager to launch 
MultiMedia Works and load the file. In this way, it is not necessary to have the original application 
that created the file.  Note that drag-and-drop object play does not require you to Register File 
Extensions; this procedure only applies if you wish to play files using double-click from File 
Manager.

1. Select Register Extensions... from the File Menu
The Register File Extensions window will be displayed.

2. Select MultiMedia Works from the drop-down list of Target Applications.
3. The Associated Extensions list will include entries for Lenel media formats such 

as .lda and .ldv.  To register additional extensions in MultiMedia Works:
a. Highlight the desired extension(s) in the File Extensions list.
b. Click on the right arrow button to add the extension(s) to the Associated 

Extensions list.
4. Click on the OK button.
5. From the Windows File Manager, you can now double-click on any file having a 

registered extnesion.  This action will launch MultiMedia Works and load the file.

Display Window Configuration

MultiMedia Works lets you customize the way different object (media) types are displayed. For 
each object type, you can define size, placement and style characteristics of the display window. 
You can also define master settings which will apply to all object types.

1. Select Display Window Config... from the Options menu.
The Display Window Configuration window will be shown with default settings 
selected.

2a. Click to select the Window Type (i.e., object type).
b. By selecting the Master Window Type, you can define a group of settings that will

apply to all object types. Then, when you select the Use Master For All checkbox 
prior to playing a particular object or show, MultiMedia Works will override all 
other Display Window Configuration settings and use the Master settings for all 
objects.

3. Choose Window Style options for the selected type
4. If you wish to have a window automatically close after the object has been 

displayed for a specific time, select Auto Close then specify the number of 
seconds of display time.

5. If you are defining the audio or analog/digital video Window Configuration, select 
an Audio and/or Video Style.

6a. Select display Window Size and Window Position using the drop-down list, radio 
buttons, increment/decrement buttons, and/or manual entry.

b. Alternatively, choose the Select Size/Position... button.  This allows you to define 
Window Size and Position by example. Use the example window's control-menu 
box to move, resize, or specify whether you are defining size and/or position.  
Then close the example window, if it isn't closed.

7. Click on the OK button.



Compressing Object Data

MultiMedia Works supports data compression for graphics and video still images.  Data 
compression reduces an object's disk storage requirement.  MultiMedia Works lets you compress 
an object during a save operation. 

1. From a graphic or analog video display window, select the Save File control.
2. A Lenel Save File Dialog window will be displayed. Click on the Compress... 

button.
3. An Image Format Options window will be displayed. Select:

a. Pixel Format - indicates the amount of color information for each "dot" of 
the image.

b. Color Reduction Method - method by which the number of colors in the 
image is reduced.  This is important if the object is to be displayed on a 
computer screen that supports fewer colors.

c. Include Desktop Colors and Dither Paletted Image are modifiers for the 
Color Reduction Method.

d. Compression Type and Quality from the drop-down lists, or use the 
horizontal scroll bar to select a compression/quality balance. The rule of 
thumb is: the higher the compression (i.e., the smaller the disk space the 
compressed image requires), the lower the quality of the resulting image.
MultiMedia Works supports compression of .tif, .jpg and .cmp objects 
using JPEG, Lead, and/or TIFF CCITT standards.

e. Click on the Set Default button to establish your settings as the default 
for the current File Type.

The size of a saved object depends on the Pixel Format, the number of pixels in the original 
object and the Compression Type. Since Image Format Options are numerous and sometimes 
complex, we suggest that you try different combinations, then view the resulting compressed files 
to get a first-hand understanding of the different methods available to you. Your User Manual 
describes Image Format Options in greater detail.

Multimedia Show Builder
Multimedia Show Builder enables you to create multimedia shows which can then be played back
on your PC.  Show Builder provides complete flexibility including the ability to:

- Use any multimedia objects supported by MultiMedia Works, including audio, analog & 
digital video, animation and graphics

- Resequence any or all show objects
- Specify the number of repetitive plays for an object
- Jump to any object in the show sequence
- Control when to start playing the next object in the show
- Select color(s) and/or graphic(s) to use in the background while the show is played
- Select the playing time for individual or all objects
- Customize the window display characteristics for individual objects or for different show 

data types
You can even embed MultiMedia Works shows into other applications from which the shows can 
then be played.



Creating a Show
You can create multimedia presentations using MultiMedia Works' Show Builder function. Shows 
are created from a Show Builder window, which contains an Objects List and a Show List. The 
Objects List is located in the left portion of the window. You will drag-and-drop all potential show 
items into this Objects List. The Show List is located in the right portion of the window. You will 
copy objects from the Objects List to the Show List to build your presentation. From the Show 
List, you can then change object and presentation characteristics to customize your show.

From the MultiMedia Works application base screen:
1. Select Show from the Multimedia drop-down menu, or select the Show button 

from the toolbar. The Show Builder window will be displayed.
2. Display File Manager by either:

- pressing the F4 key, or
- selecting the Start File Manager command from the Control-Menu box
Resize/position your screen so that both File manager and Show Builder 
windows are visible.

3. Drag-and-drop the objects you want in your show from File Manager over the 
Show Builder window. As you drop objects on the MultiMedia Works Show 
Builder window, their filenames(s) will appear in the Objects area of the window. 
Note that, if you wish to play any object in this Objects list, you can do so by 
double-clicking on the list entry for that object.

4. As an alternative to using File Manager, selecting the Locate Object command 
from the Edit menu will display a Lenel Open File Dialog window, with "All Files 
(*.*)" as the default filename extension.  Use this window to add objects to the 
current show.  Once the desired object is selected in the Open File window, 
selecting the OK button closes the window and places the selected object into 
the Objects list of the current Show Builder window.

From the Objects list:
5. Select the objects from the Objects list that you want in the show using any of the

following methods:
- select the ALL button to select all objects in the list
- click on individual objects
- use the Shift key to select a range of objects
- use the Control key to select multiple objects

6. Select the right arrow button to place the selected objects in the show.
An entry for each selected object appears in a Show List in the rightmost portion 
of the Show Builder window. Note that you can have multiple entries for the same
file; for example, you may wish to play the same audio object at the beginning 
and at the end of your presentation.

7. You can resequence show objects using either of these methods:
a. To move one object, highlight the object then click on the plus (+) or 

minus (-) button to move the object up or down in the sequence.
b. To resequence the entire show, click on the ReOrder button.  Then click 

on each object individually in the desired order. Note that as each object 
is selected, its sequence No. appears beside it in the Show List. 



Selecting a Background Color and Graphic
You can assign a color to be displayed in the background of your show.  You can also assign a 
graphic object (your company logo, for instance) to be displayed at a designated size and position
on the screen during the show. You can also have different background colors and objects for 
different portions of your show. 

From the Show Builder window:
7. Double-click on Bckgrnd in the Show List.  The Show Background Settings 

window will be displayed showing the default background color (black).

Specifying a background color for your show:
8a. From the Show Background Settings window, select the PICK COLOR button.  

The Windows Color Palette window will be displayed.
b. Select the desired color (or define and select a  custom color) and then select the

OK button.  The selected color will be shown in the Color: field of the Show 
Background Settings window.

Selecting a Background Graphic:
9. From the Show Background Settings window, select the desired show graphic 

using either:
- the drop-down list from the Graphic field, or
- the FIND... button, which displays a Lenel Open File Dialog box.  Select the 

type of file and then the specific graphic object; click on OK.

To select a size and screen position for the background graphic:
10. Select the SIZE/POSITION... button.  A Display Window Configuration window for

the background graphic will be displayed.
11. Select the Window Size and Window Position for the graphic, then click on OK.
12. Select OK to close the Show Background Settings window.
13. You can change these background settings by double-clicking on the Bckgrnd 

entry in the Show List, which activates the Show Background Settings window.

To specify playing characteristics for a particular object in the show:
14a. From the Show Builder window, double-click on any entry in the Show List 

(except Bckgrnd) to display the Playback Characteristics window.
1) Select a Repetitive Playback option to indicate the number of times you 

want the object to be played at that point in the show.
2) Select a Begin Next Item option to specify when to play the next object in

the show sequence. Note that you can set the timing controls to play 
multiple objects simultaneously, or to overlap objects.

3) If you specify a value for Display for ...Seconds, MultiMedia Works will 
play or repeat play the object for this length of time.

4) You can also choose to play the object for the Default Time for Window 
Type, as defined in the Display Window Configuration window.

b. Note that you can click on the Options... button from the Show Builder window to 
activate the Playback Characteristics window.  From there, click on the 
Configure... button to activate the Display Window Configuration window.

c. Note also that you can click on the Configure... button from the Show Builder 
window to activate the Display Window Configuration window.



To Play a Show

To play a show from the Show Builder window, either:
- select the Play option from the Display menu, or
- press the F9 key

The show objects will play in the specified sequence.

Other Show Playback Options

In addition to these object-related options, show-related options are available from the Display 
menu in the Show Builder window:

Minimize on Play  - configures the show to minimize MultiMedia Works during show 
play. This option does not itself actually start the show.

Continuous Play - starts the show and plays it continuously, until the End key is pressed
or the Stop control is selected.

Password Play  - requires the user to enter a password to start the show. The show then
starts, and the user must enter the same password to stop the show.

Password Show

If the Password Play option is selected, the user will be prompted to enter a password before the 
show will commence.  Once the correct password has been entered, continuous show play will 
begin.  When the user tries to stop the show, he/she will once again be prompted to enter a 
password.  If the correct password is entered, the show will be stopped; otherwise, it will continue
to play.

Multimedia-Enabling Server
MultiMedia Works software allows you to embed multimedia objects into other Windows-based 
applications using a variety of methods including:

- Windows clipboard including Object Linking and Embedding (OLE)
- Dynamic Data Exchange (DDE)
- Command-line interface
- Dynamic Link Library (DLL) calls (using MultiMedia Works' Application Programming
  Interface)*

*Note: DLL is available only with the MultiMedia Works Developer's Toolkit.

This flexibility enables MultiMedia Works users to embed multimedia data into other commercial 
or custom Windows applications using the method with which they are most comfortable.
 



Using Windows Clipboard and OLE

To copy a MultiMedia Works object to the Windows clipboard from the application base screen:
1. Display the desired object or show in a MultiMedia Works display window.

2. Select either the:
- Copy To Clipboard icon, or
- OLE Copy command from the Edit menu for shows

The selected object or show will be copied to the Windows clipboard.

To paste the object or show into another application:
3. Open the desired application file (e.g., Microsoft Word for Windows document).
4. Position the cursor where you want the object or show to be pasted.
5. Select one of the following Paste commands in the destination document:

- Paste or Paste Special/Object - Embeds the MultiMedia Works object into the 
destination document.

- Paste Special/Picture or Paste Special/Bitmap - Pastes a pictorial 
representation of the object data into the destination document.

Playing Embedded Objects

To play the embedded object in the destination document:
1. Double-click on the object thumbnail or Lenel icon.

If it is not already active, the MultiMedia Works application will automatically be 
started and the object will play in a display window.

To close the object window in the destination document:
2. Select the EXIT control.

The Lenel object will revert back to its iconic or thumbnail form in the destination 
document.

Using DDE

Microsoft's Dynamic Data Exchange (DDE) is useful when you wish to embed multimedia objects 
in applications that do not support OLE.

MultiMedia Works fully supports DDE as follows:
- DDE Execute command
- Service Name: LnlServer
- Topic Name: System
- Command Name: "Open"
- Item: File name of the multimedia file to play

MultiMedia Works also includes DDE macros for use with the following applications:
- AmiPro
- Microsoft Excel
- Microsoft Word for Windows

For more information on using Microsoft's DDE capabilities, consult the Microsoft Windows 
Version 3.1 Software Developer's Kit (SDK).



Command-Line Interface

MultiMedia Works also supports Microsoft's command-line interface. This interface is useful to 
start the MultiMedia Works application from another application using a Windows call (e.g., via 
the Run... command). Available commands include:

-f[full pathname for show] plays the specified show
-k initiates continuous play of the show
-p initiates password play of the show. The user

will be prompted for a password to start and
end the show

An example:
The command   c:\mmworks\mmworks.exe -fd:\sales93\demo2.lsi    plays the MultiMedia 
Works show demo2.lsi, which is located in the directory sales93 on drive d:.



Multimedia Mail
If you are a Windows for Workgroups user, you can use the Multimedia Mail function to send any 
MultiMedia Works object or show to other Workgroups users on your network.

Logon

The Logon command establishes a link between MultiMedia Works and the Windows for 
Workgroups mail system.

1. Select the Logon command from the Multimedia Mail menu
The Windows for Workgroups Mail Sign In window will be displayed.

2. Enter your user name and password.
3. Click on the OK button.

Retrieving New Mail

1. Select the Check For New Mail command from the Multimedia Mail menu.
A Lenel Mail Status Monitor window will be displayed, providing a summary of 
new mail received.

2. To read mail from this window, select the desired message, then click on the 
READ MAIL... button

Sending Mail

1. Select the Send Mail command from the Multimedia Mail menu.
The Windows for Workgroups mail system's Send Note window will be displayed.

2. Complete the envelope (To:, Cc:, Subject:) portion of the window

To compose a multimedia message:

1. Display the desired object or show in a MultiMedia Works display window.
2. Copy the object or show to the Windows for Workgroups clipboard by using the:

- Copy To Clipboard control for objects, or
- OLE Copy command from the Edit menu for shows

3. Position the cursor where you want the object or show to be pasted.
4. Paste the copied object or show into the Send Note window
5. Click on the Send button.

Logoff

The Logoff command closes the link between MultiMedia Works and the Windows for 
Workgroups mail system.

1. Select the Logoff command from the Multimedia Mail menu.


